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1. [bookmark: _Toc159574753]General 
[bookmark: _Toc159574754]1.1 Reference to internal or external textual or graphic objects is made by explicit naming, not solely by means of a description via visual or auditory features.
What is meant by this? 
Reference must be made to the objects used by explicitly naming and describing them in the existing text. Internal textual objects refer to texts, headings, footnotes, endnotes and text fields. External textual objects are, for example, hyperlinks. Graphical objects, on the other hand, include images, shapes, diagrams, tables, SmartArt and WordArt. All these objects may not only be referenced by their visual and auditory characteristics such as colour, size, shape, position, volume or pitch, but also require a clear designation in text form. It is advisable to give the object a meaningful name directly in the text, link to it and refer to it in the description. 
Why is it important? 
For the accessibility of documents, it is important that textual or graphic objects are understandable regardless of a particular sensory characteristic, such as sight or hearing. Recipients who primarily use one sensory channel (visual or auditory) may otherwise not be able to perceive this information. For example, recipients with visual impairments or blindness may have difficulty understanding the content of objects if the content is only recognisable through visual features or descriptions. While recipients with hearing impairments or deafness may have difficulty forming a picture of an object based on descriptions that refer exclusively to acoustic features.
By clearly naming and describing textual and graphic objects, documents become accessible to all recipients and provide orientation. 
How can I implement/check this?
If you want to write a precise reference for an internal or external textual or graphical object in Word, it is advisable to follow the steps below:
1. First, you should identify the object and make sure it has a clear and concise name. 
2. You should then describe the object in one or two sentences to convey its function and meaning. Use clear and precise language to avoid misunderstandings. 
3. Next, it is advisable that you add a unique identifier, such as a number or letter, to clearly identify the object. This is particularly important if you refer to several objects on the slide. 
4. Once you have the clear labelling and description of the object, you can insert the reference into the text. Use the labelling and description to make your reference clear and precise.
The following list contains recommended formulations for textual references to objects in Word:
1. As shown/visible in the table/figure [number]...
2. As shown in [author(s), year]...
3. As described/mentioned in [slide title, page/paragraph number]...
4. As noted in [name of study, year]....
5. As shown/mentioned in the previous [table/figure, section]...
6. As shown in the data/results of [study name, year]...
7. As mentioned/said in [author(s), year, page/paragraph number]...
8. As mentioned/explained in the [section or chapter number]...
9. [bookmark: _Toc159574755]As can be seen in the red sphere [placement of the sphere on the slide]...

1.2 The use of colours is generally sparing.
What is meant by this?
A restrained and appropriate use of colours to convey information should be aimed for. Before the integration of colours into an information medium, it is advisable to carefully consider whether and to what extent they can contribute to improving the communication of information.
Why is it important? 
For some recipients, too much colour can be a distraction or disrupt the reading flow due to strong visual perception. In addition, there are recipients who cannot perceive all colours clearly or who work independently of colour. If information is conveyed exclusively through colour, these recipients may miss important information or not understand it. 
How can I implement/check it? 
It is recommended that the number of colours used is kept to a minimum in order to convey a clear and understandable message. In addition, when deciding on the use of colours, consideration should also be given to their necessity to ensure that they actually add value to the communication of information. 
If colours are nevertheless used to convey information, this information should also be conveyed in other ways, such as symbols, lettering or patterns (see 1.3). 

[bookmark: _Toc159574756]1.3 If colours are used to convey information (e.g. in diagrams or to mark text), labels, symbols or patterns convey the same information.
What is meant by this?
It is recommended that information is not only represented by colours, but also by labels, symbols or patterns. This means, for example, that colour AND pattern should be used in a diagram to represent a bar. For example, buttons in the colours green and red are also described with "yes" and "no". This creates opportunities for the information to be better perceived visually.
Why is it important? 
If information is presented exclusively through colours, recipients who do not perceive all colours clearly may have difficulty understanding this information. There is a risk that information that is only conveyed via colours will be lost on such groups of people. For example, recipients with colour vision deficiency have difficulties perceiving certain colours or contrasts. Colours with the same saturation can prevent full perception of what is shown and result in not all information being absorbed. Grey contrasts should also only be used to a limited extent, as recipients with colour vision problems may have difficulty recognising certain shades of grey or differences in brightness.
Through the additional use of labels, symbols or patterns, information can be presented in several ways to ensure that it is also accessible to groups of people who work independently of the colour display, are distracted by bright colours or perceive stimuli very strongly. 
How can I implement/check it? 
For example, to add a pattern to a diagram in Word, you can proceed as follows:
1. Click on the diagram to select it.
2. Click on "Diagram tools" and then on "Design" or, if you are using a Mac, on "Diagram design" in the menu bar.
3. Click on "Select data" and select the data points to be labelled.
4. Click on "Format" and select "Format data series". Depending on the version you are using, Excel will then open if it is a chart from Excel. 
5. Select the "Pattern" option under "Filling" and choose a desired pattern.
6. Click on "Border colour" and select a colour for the border of the pattern.
7. Select "Border thickness" and adjust the width of the border.
8. Click on "Close" to close the dialogue box and save your changes.

You should also add a label to each diagram in Word and proceed as follows:
1. Click on the diagram to select it.
2. Click on "Diagram tools" and then on "Layout" in the menu bar if you are using Windows. If you are using a Mac, this point is skipped. 
3. Click on "Add diagram element" and select "Axis labelling".
4. Select either "Primary axis horizontal" or "Primary axis vertical", depending on which axis you want to label.
5. Select "Axis labelling" and enter the desired text.
6. Click on "Format" and adjust the font, font size and colour of the label.
7. Repeat steps 3-6 if you want to add a label for the other axis.
Alternatively, you can also add a title bar or legend to label diagrams.
Diagrams and other representations should be viewed in different ways to check accessibility, for example by hiding colours or changing the brightness to ensure that the information is easy to understand regardless of colour. There are various ways to do this. 
Print the respective page in greyscale to get an idea of how your displays look without colours. In addition, you can set the brightness of your end device from "very high" to "very low" and check whether the information is still accessible.
[bookmark: _Toc159574757]2. Document
[bookmark: _Toc159574758]2.1 The main language of the document corresponds to the language set for the spell checker.
What is meant by this? 
It is important that the language set for the spell checker in Word matches the language that is primarily used in the document. In this Word document, for example, the main language is set to German, which means that the spell checker automatically works in German because Word recognises the language used. If several languages are used in a document, the language for certain sections or words can be changed manually to ensure that the spell checker works correctly (see 3.1).
Why is it important? 
It is important that the main language of the document matches the language of the spell checker to ensure that the document is read out correctly in terms of pronunciation using speech output programmes. Otherwise, a document may be difficult to understand for recipients with limited reading ability, learning difficulties or visual impairments who have documents read to them with the support of a screen reader. If the actual language does not comply with the spell checker, this can lead to incorrect pronunciation by the screen reader and voice output, so that the content of the document is misunderstood or distorted in its meaning. 
How can I implement/check it? 
To customise the main language in a document, there are different procedures for Mac and Windows operating systems:
For Mac:
The main language in Mac cannot be customised. The main language applies during installation.
For Windows:
1. Click on "Check" in the menu bar.
2. Select the "Language" button.
3. Click on "Set language for the correction aids".
4. If you have frequently used languages, you can create a style sheet to save time.
5. Run the spell check in the "Check" ribbon in the "Language" tab.
6. If no spelling errors are displayed and the language is correct, the main language of the document matches the language of the spell checker.

It is advisable to create a style sheet for frequently used languages to save time. To check the set main language, run the spell checker in the "Check" ribbon in the "Language" tab. 

[bookmark: _Toc159574759]2.2 The title is stored in the metadata, is meaningful, easy to understand and corresponds to the first heading of the document.
What is meant by this?
It is important to make the title of a document easy to understand and meaningful, which means that the title should be formulated in simple and clear words that adequately reflect the content of the document. The title should enable readers to quickly recognise what the document is about and what purpose it fulfils. This title must be stored in the metadata to make it easier for users to identify and organise the presentation. 
Metadata is information that describes or identifies a document and is usually invisible to viewers. It includes various properties, such as the title, the author, the creation date, the file format and the size of the file. Keywords or keywords can also be used as metadata to describe the content of the document and make it easier to find for later searches or archiving.
Why is it important? 
A meaningful and easy-to-understand title that is stored in the metadata facilitates orientation and approval of a document for recipients who are dependent on speech output and screen readers. Recipients with visual impairments or learning difficulties are often unable to scan the document visually to determine whether it is relevant to them. Instead, they have to rely on voice output and screen readers to understand the content. A meaningful and easy-to-understand title can help them quickly grasp the content of the document and decide whether or not the text is relevant to them.
An example of a meaningful and easy-to-understand title would be "Guide to document accessibility". This title gives readers a clear idea of what the document is about. A bad title, on the other hand, would be "Accessibility", for example. This title is too general and does not tell readers specifically enough what the content of the document is. This title can lead to irritation and a considerable amount of time for readers with screen readers and speech output.
How can I implement/check it?
There are different procedures for entering the title of a document in the metadata, depending on the operating system: 

For Mac: 
1. Click on "File".
2. Click on "Properties" in the "Summary" tab to access the metadata.
3. Enter the title in the field provided.

On a Windows computer:
1. Click on the "File" tab.
2. Click on "Information".
3. Enter the title in the field provided.

To check whether the title is correctly stored in the metadata, you can click on the "Info" tab and check the information. You can also go through the document and make sure that the title on the first slide corresponds to the title in the metadata. 
Whether a title is ultimately meaningful or not is up to you to decide. But remember that reading decisions should already be made by the title. 

[bookmark: _Toc159574760]2.3 Extensive documents have a table of contents at the start date.
What does that mean? 
For longer texts or documents, a table of contents should be created to provide an overview of the chapters and sections of the document. A table of contents is a list of the chapters or sections of a document. It gives the reader an overview of the content and structure of the document and makes it easier to find specific topics or sections. The table of contents is usually located at the start date of the document and indicates the page number on which the respective section begins. 
It is advisable to create a table of contents from the templates in Word, as this can be updated quickly when changes are made to the document. This allows readers to quickly and easily access specific sections of the document via the hyperlinks within the table of contents.
Why is it important? 
A table of contents proves to be extremely valuable for recipients who need a clear structure in order to find their way around a comprehensive document. It is an indispensable tool for orientation and navigation within a document and can save readers the time-consuming search for relevant information.  
How can I implement/check it?
If a table of contents is present in a document, it should ideally be formatted as a separate element of the document. To check this, simply click anywhere in the table of contents. A frame should form around the table of contents. A button with the text "Table of contents" or similar will also appear.
If no table of contents is available, you can have it generated automatically. To do this, proceed as follows: 
1. Click on a place in the document where you want to insert the table of contents. 
2. Now click on "References" in the menu bar at the top and then on "Table of contents". 
3. Finally, select the desired table of contents format.
Please note that in order for the table of contents to be generated correctly, the headings in the document must be created with the appropriate format templates and the table of contents must be updated again when the document is finalised (see 5.1).

[bookmark: _Toc159574761]2.4 The header and footer are created using appropriate styles and are free of relevant information (page numbers are permitted).
What is meant by this?
The header, footer and slide numbers in Word are important elements for orientation, but should not contain any relevant information. Instead, they should be provided with placeholders such as "Date" or "Title".
If headers and footers are used, they should be created with appropriate styles to ensure that all headers and footers in the document have the same properties such as font, size and colour. 
Why is it important?
It is important to keep headers and footers free of relevant information, as screen readers and voice output devices often do not read out information from headers and footers and important information could therefore be overlooked. If headers and footers are read out by screen readers and voice output devices, this disrupts the reading flow because they are read out again on every page. 
The use of style sheets for headers and footers is an important aspect, as the use of style sheets can ensure that headers and footers can be found quickly and easily. The use of style sheets can also ensure that changes to the header or footer are applied to all pages of the document on which this style sheet is used. If the headers are different on each page, this could be confusing for the screen reader and speech output. 
How can I implement/test it?
Styles should be used to set headers and footers in Word documents. To do this, proceed as follows: 
1. Click on "Insert" and then "Header" or "Footer"
2. Now select the option "Edit header" or "Edit footer". You should receive approval for the information stored in the header or footer and be able to edit it.
3. If this is not the case, this indicates that no style sheets were used to create the header or footer.
In addition, it is also possible to design the header and footer by double-clicking on the corresponding line at the start date or end of the document and entering the desired text. 
When editing the header or footer, make sure that it does not contain any information that is important for understanding the document content. 
In addition, use the functions offered by Word under "References" (see 2.5). 

[bookmark: _Toc159574762]2.5 Footnotes, endnotes and references are based on the functions offered by Word under "References".
What is meant by this? 
Footnotes, endnotes and references are functions in Microsoft Word that can be found under the "References" tab. Footnotes are short notes that are displayed at the end of a page, while endnotes are displayed at the end of the document. References are links to other places in the document, such as page numbers or headings. These features allow readers to obtain additional information on a particular topic and to better understand the content of the document.
Why is it important? 
If footnotes, endnotes and references are used, these should be created using Word templates to ensure the reading order and references in the document. This is particularly helpful for recipients who use speech output or a screen reader and improves the readability and comprehensibility of a document, especially for recipients who have the document read to them and only navigate using the keyboard. 
Without using the "References" functions in Word, it can be difficult to ensure consistent and easy-to-read formatting of footnotes and references. This can lead to difficulties when someone tries to read or edit the text, especially if they have a visual impairment or motor impairment. For example, if the footnotes and references are not numbered or are in different places on the page, it may be difficult for that person to find and read them.
How can I implement/test it?
To use footnotes, endnotes and references in a Word document, proceed as follows:
1. Place the cursor at the point in the text where the footnote or reference is to be inserted.
2. Click on the "References" tab and select the appropriate option (footnote, endnote or reference).
3. Enter the text of the footnote or reference and format it accordingly.
4. If you want to create a link, select the text you want to refer to and click on "Insert link".
5. Select the desired reference type (page number, heading, figure and so on) and click on "OK".

[bookmark: _Toc159574763]3. Text
[bookmark: _Toc159574764]3.1 The text passages that differ from the main language are marked with the appropriate language (language change).
What is meant by this? 
If a document is written in several languages, it is important to indicate passages that differ from the main language in the other language. 
The main language of a document is the language that is used most frequently in a document and that best describes the content of the document. Defining the main language of a document is important as it determines which spell checker, grammar checker and other language-specific functions are used.
A language change refers to the change of language for a specific section or word in a document that differs from the main language. If sections or words within a document are required in a different language, for example when using quotations, foreign-language terms or in a multilingual document, these must also be marked with the corresponding language.
Why is it important? 
Marking language changes is important for the accessibility of documents, as it helps recipients who use speech output or a screen reader to better understand the text. 
If this person uses a screen reader or voice output to read the presentation, they may have difficulty recognising and understanding text passages that differ from the main language, as screen readers and voice outputs do not automatically recognise different language and pronunciation is based on the stored language. 
Marking language changes therefore enables screen readers and voice outputs to use the correct pronunciation.
How can it be implemented/checked? 
In Word, you can mark language changes as follows:
1. Select the text that is to be labelled in a different language.
2. Click on the "Check" tab or, if you are using a Mac, on "Extras" and then on "Language".
3. On a Windows computer, select the language in which the text is written from the "Add language" drop-down menu or select a corresponding language on a Mac.
4. Repeat this process for all text passages that are written in another language.
Alternatively, it is also possible to change the language of the document in the bar below the document using the "Language" function.

[bookmark: _Toc159574765]3.2 The font is sans serif (e.g. Arial, Helvetica) and not too thick or too thin. 
What does that mean? 
It is advisable to choose a sans serif font that is neither too thick nor too thin to ensure optimum legibility. The main focus here is on recognising and distinguishing individual letters and words.
Serifs are small decorations or lines that are attached to the ends of the letters. Sans serif fonts have clear and smooth lines and appear more modern and simple than fonts with serifs.
It is important that the stroke width of fonts is between 10% and 20% of the centre length to ensure sufficient contrast. Fonts without serifs, where the difference between the thickness of the lines of the letters is small, are best suited and correspond to the "Normal" or "Regular" weights. Fine and bold font weights and fonts with high line weight contrast should be avoided, especially when formatting the entire text.
Why is it important? 
Sans serif fonts are easier to decipher, especially for people who have difficulty following the reading flow or recognising and reading the text. This is because fonts with serifs (e.g. New Times Roman) can cause letters to blur into one another or be more difficult to read for some people, as the serifs vary the letter shapes more. In addition, fonts that are too thin or too thick can affect legibility, especially for staff, people with impaired vision.
How can I implement/check it? 
In order to select fonts that are suitable for recipients with visual impairments, the recognisability, distinctiveness and openness of the characters as well as a low line width contrast should be taken into account. Different font classifications and design principles can influence these factors. The following fonts are therefore recommended: Arial, Calibri Regular, Helvetica, Lucida Sans Regular, Verdana Regular, Noto Sans Regular, Open Sans Regular, Source Sans Pro Regular and Fira Sans Regular.
Set sans serif font:
1. Select the entire text or the section in which you want to change the font.
2. Click on the "Start" tab in the menu bar.
3. Select a sans serif font from the drop-down menu in the font selection.

[bookmark: _Toc159574766]3.3 Emphasis using capital letters, italics, bold, underlining or text effects (colour gradient as colour fill, glow effects, text outline) is used sparingly.
What does that mean?
[bookmark: _Hlk139361397]The highlighting of text passages using capital letters or text effects such as colour gradients, glow effects or text contours should be used sparingly. In addition to capital letters, such highlighting can also include italicised and bold text, underlined text and text effects, as well as shadows, soft edges, reflections or a luminous look. This emphasis should be limited to individual words at most, so as not to disrupt the flow of reading and to ensure a clear structure. It is important to ensure that the font is sans serif and not too thick or too thin (see 3.2). 
Why is it important? 
Emphasising with capital letters or eye-catching text effects can disrupt the reading flow and impair the readability of the text. If, for example, important information is highlighted with various text effects such as glow effects, colour gradients and other highlights, this can distract readers from the actual content. However, a clear structure and easy readability are particularly important for recipients who have difficulty following the flow of the text or recognising/reading it. Many effects and highlighting can also have an overstimulating effect.
How can I implement/check it? 
To check the text for highlighting, proceed as follows: 
1. Take a look at the document.
2. Search for text passages that have been highlighted in bold, italics or coloured markings.
3. Consider whether the means used actually offer added value for understanding the document content.
4. Select the text that should not be italicised or underlined.
5. Click on the "I" (for italics) and/or the "U" (for underlining) in the formatting bar to remove these formatting options. 
[bookmark: _Toc159574767]3.4 The line spacing is at least 1.2 pt.
What does that mean? 
Line spacing in Word refers to the vertical distance between the lines in a paragraph. For good readability, the line spacing should be at least 1.2 pt. or 120% of the character size. However, in order not to disrupt the flow of reading, the line spacing should not be disproportionately large. 
Why is it important?
Line spacing that is too small can impair the legibility of texts and cause visual overload. This can make it difficult for the eyes to focus on the next section of the text, which can lead to a reduced reading speed and a higher error rate. In addition, small line spacing can also lead to increased eye strain and fatigue, especially with longer texts. 
Sufficient line spacing of at least 1.2 helps recipients who have difficulty reading or concentrating to follow the flow of the text and decipher the content better. It also helps to create a clear structure in the text.  Adequate line spacing makes it easier for the eyes to find the beginning of the line when skipping to the next line.  
How can I implement/check it?
There are different procedures for setting the line spacing to at least 1.2 pt. for Mac and Windows operating systems: 
For Mac:
1. Select the section of text in the document whose line spacing you want to check.
2. Right-click on the selected area and select the "Paragraph" option.
Alternative: 
1. Select the section of text in the document whose line spacing you want to check.
2. Click on "Start" in the menu bar at the top.
It follows:
3. Select the "Line and paragraph spacing" button.
4. Now click on the "Line spacing options".
5. A new "Paragraph" window opens. Click on the "Indents and spacing" tab.
6. You will find predefined line spacing under the "Line spacing" section. Check whether the "1.5 lines" option is selected. If so, the criterion is met and you can leave the "Dimension" field empty.
7. If the "1.5 lines" option is not selected, select "More" and enter the value 1.2 or higher in the "Dimension" field.
8. Click on "OK" to save the changes you have made. 
For Windows:
1. Select the text section in the document whose line spacing you want to check.
2. Click on "Start" in the menu bar at the top.
3. Select the "Line and paragraph spacing" button.
4. Now click on the "Line spacing options".
Alternative: 
1. Select the section of text in the document whose line spacing you want to check.
2. Right-click on the selected area and select the "Paragraph" option.
It follows: 
3. A window opens in which the line spacing is specified under "Spacing".
4. There are predefined line spacings such as "Single" and "Double". However, to ensure that the criterion is met, an explicit line spacing of at least 1.2 pt. should be entered in the rightmost field under the "From" label.
5. If the value in the field under "From" is already 1.2 pt. or higher, the criterion is fulfilled and you can click on "OK".
6. If the value under "From" is less than 1.2 pt., this must be increased to at least 1.2 pt.
7. Enter the value 1.2 pt. (or higher) in the field under "From".
8. Click on "OK" to save the changes.
To check the line spacing in a text, you can select a paragraph and then click on the "Line and paragraph spacing" icon in the "Paragraph" group on the "Home" tab. There you can view the current line spacing and adjust it if necessary.
Alternatively, you can also activate the "Paragraph marks" option in your word processing programme to make the spaces between the paragraphs visible.

[bookmark: _Toc159574768]3.5 The text is left-aligned.
What does that mean?
A left-aligned text is aligned to the left margin of the document. This means that all line beginnings are vertically aligned and the line ends run out freely on the right.
The left-aligned alignment is the standard alignment for most word processing programmes such as Microsoft Word or Google Docs and is often used for continuous text such as articles, reports or letters.
Why is this important?
Left-aligned formatting helps recipients who have difficulty following the flow of reading, as the lines of text start on a common left-hand margin and are therefore easier to follow. If the lines are of different lengths, it is easier to jump from one line to the next with the eyes. As justified text causes irregularly large spaces between words and more frequent word breaks, especially in narrow columns, left-aligned flush typesetting is preferable.
How can I implement/check it?
In Microsoft Word, the alignment can be done via the Home tab and the Paragraph button. The alignment can be set to "Left" there. 	
There are different procedures for testing the Mac and Windows operating systems:
For Mac:
1. Select the section of text in the document whose alignment you want to check.
2. Right-click on the selected area.
Alternative: 
1. Select the section of text in the document whose alignment you want to check.
2. Then click on "Start" in the menu bar at the top.
It follows: 
3. Select the "Paragraph" option from the context menu.
4. In the paragraph menu, click on "Indents and spacing".
5. You should be able to see the selected alignment in the window that opens. This should be left-aligned.
6. If the field is empty, this means that there are different alignments in the selected text area.
For Windows:
1. Select the section of text in the document whose alignment you want to check.
2. Then click on "Start" in the menu bar at the top.
Alternative: 
1. Select the section of text in the document whose alignment you want to check.
2. Right-click on the selected area.
It follows:
3. Locate the "Paragraph" area in the menu bar.
4. There are four buttons for text alignment in this area: left-aligned, centred, right-aligned, justified.
5. Check which of the buttons is highlighted in grey. This is the current alignment of the text you have selected.
6. The alignment should be left-aligned.

[bookmark: _Toc159574769]3.6 Paragraphs are not created with tabs or soft line breaks, but with paragraph breaks (i.e. there are no blank lines in the document).
What is meant by this? 
A new paragraph in a document should be created with a paragraph break instead of a tab or a soft line break. A paragraph break is a function that is used to end a paragraph and start a new paragraph on the next line. A paragraph break is used to start a new paragraph without inserting additional line spacing between the two paragraphs. 
Why is it important? 
It is important to avoid the use of soft line breaks and to use paragraph breaks instead. Recipients with screen readers navigate from paragraph to paragraph within texts and have the beginnings read out to them in order to grasp the content of the paragraph. If a soft line break is used to separate paragraphs, the screen reader does not recognise this as a new paragraph and "New line" or "Blank line" is read out, which can disrupt the reading flow. 
This can make the text unnecessarily long and confusing for recipients who use a screen reader or voice output. It can also make the content of the document more difficult to grasp, as the connection between the paragraphs is distorted. Instead of blank lines, paragraph spacing should therefore be used to structure the text. Paragraph spacing adds additional space between paragraphs without causing unnecessary breakdowns when lecturing.
How can I implement/check it?
In Microsoft Word, you can create a paragraph break in various ways:
1. Using the ribbon: Click on the "Insert" tab and then on the arrow next to "Symbol". Select "Paragraph mark" from the drop-down menu to insert the paragraph break.
2. Use the context menu: Right-click where you want to insert the paragraph break. Select "Insert paragraph break" from the context menu.
3. Using the Enter key: Press the Enter key on your keyboard at the point where you want to insert the paragraph break. 
There are different procedures for checking your document for paragraphs, depending on the operating system: 
For Mac:
1. Click on the "Start" tab at the top of the menu bar.
2. In the "Paragraph" group, click on the "Display/hide symbol" button (a symbol with the appearance of "¶"). This makes all paragraph formatting in the document visible.
3. Check the document for empty lines. These should only consist of the "¶" symbol.
4. Remove all other symbols (e.g. spaces, tabs) with the support of the "Del" or "Backspace" key.
5. Instead, insert a paragraph break at each point where you want a new line to start by pressing the "Enter" key.
6. Check the document again for empty lines to ensure that all paragraphs are separated by paragraph breaks and not empty lines.
For Windows: 
1. Click on the "Start" tab in the menu bar at the top.
2. Look for the icon with the name "Display all". It is usually located in the "Paragraph" group and looks like a "¶" symbol. Click on it. This will make all paragraph formatting in the document visible, including any blank lines that may be present.
3. Check whether there are blank lines in the document. They should only consist of the "¶" symbol.
4. Remove other symbols that may be present in the blank lines or elsewhere in the document by selecting them and pressing the "Del" or "Backspace" key on your keyboard.
5. Instead, insert a paragraph break at the places where you want to have blank lines by going to the corresponding position and pressing the "Enter" key on your keyboard.

[bookmark: _Toc159574770]3.7 Page or column breaks are not created with blank lines, but with the page or column break.
What is meant by this? 
In a document, page or column breaks should not be created by inserting blank lines (using the Enter key). Instead, the page or column break functions should be used to create a clear separation. 
A page or column break is a function that can be used to mark the end of a page or column and start a new section. Page or column breaks are used, for example, to create a document with several columns or to ensure that a new chapter starts on a new page. They can be added manually or generated automatically by Word, depending on the settings. 
Why is it important? 
The use of blank lines instead of page or column breaks can lead to barriers. This is because screen readers and speech outputs have difficulty interpreting the text correctly when blank lines are used to create a new paragraph structure. In particular, blank lines created by simply using the Enter key can be read out as "blank", which disrupts the reading flow.
How can I implement/check it? 
In Microsoft Word, you can insert a page or column break as follows:
· Page break: Click on "Insert" and then on "Page break".
· Column break: Click on "Page layout" and then on "Columns" and select the number of columns. If you already have a column and want to add another one, position the cursor where you want to insert the column and click on "Layout" and then on "Columns" and select "More columns".
In order to check whether page or column breaks have been created correctly, you will need to follow different procedures for Windows and Mac operating systems: 
For Mac:
1. Click on "Start" in the menu bar at the top.
2. Click on the "Show/hide formatting characters" button with the "¶" symbol. This will make all paragraph formatting visible in the document.
3. Check the document for page or column breaks. If these were made using the page break functions available under "Layout", they are explicitly labelled as "Page break" or "Column break" in the document.
4. If page or column breaks are not explicitly labelled, look for many empty lines in the document.
5. Replace the empty lines by using the paragraph formatting option "Page break" or "Column break", as required.
6. Check the document again to ensure that all page and column breaks are correctly labelled and that there are no unwanted blank lines.
For Windows:
1. Click on the "Start" tab.
2. In the "Paragraph" area, click on the "Display all" button with the "¶" symbol. This makes all paragraph formatting in the document visible.
3. Check the document for page or column breaks. If these were made using the page break functions available under "Layout", they are explicitly labelled as "Page break" or "Column break" in the document.
4. If page or column breaks are not explicitly labelled, look for many empty lines in the document.
5. Replace the empty lines by using the paragraph formatting option "Page break" or "Column break", as required.
6. Check the document again to ensure that all page and column breaks are correctly labelled and that there are no unwanted blank lines.

[bookmark: _Toc159574771]3.8 Columns are not inserted via tabs, but via the "Layout" menu. The space between the columns is large enough to visually separate them from each other.
What is meant by this? 
When using columns in Microsoft Word, it is advisable to use Word's ready-made column templates. These can be inserted via the "Layout" menu and ensure a consistent presentation of the document. 
In Microsoft Word, columns are a way of dividing the text in a document into several vertical sections. This makes it possible, for example, to organise long texts more clearly by dividing them into several columns. The columns can be the same size or have different widths, and different numbers of columns can be created as required, although not too many columns should be used for the sake of clarity. 
If several columns are used in a document, sufficient space should be left between these columns so that they stand out visually from one another and are easier for recipients to recognise. The space between columns should always be at least 6 mm. 
Why is it important? 
If columns in Microsoft Word are not created using the layout tool, but by manually inserting tabs or spaces, this can lead to problems with screen readers and speech output reading and interpreting the content. It is therefore important to use Word's layout tools to create columns to ensure that the document is accessible and barrier-free.
If the space between the columns is not large enough, this can affect the legibility of the document, as the text appears to overlap for some readers and therefore becomes illegible. For recipients with visual impairments or other limitations, such as dyslexia, it can be difficult to perceive the text spacing between closely spaced columns. In addition, if the text spacing is too narrow, the letters may merge for the recipients or words may be displayed incompletely.
A suitable column width or the use of spacing between the columns can therefore increase readability so that all recipients can read the document without restrictions.
How can I implement/check it?
To check columns, there are different procedures for Mac and Windows operating systems: 
For Mac: 
1. Click on "Start" in the menu bar at the top.
2. Then click on the "Show/hide formatting characters" button with the "¶" symbol. This will make all paragraph formatting visible in the document.
3. Now take a look at the columns in your document. There should be no arrow symbols "->" between the columns, as these arrows represent tabs.
4. Alternatively, you can also check whether you can select the texts column by column. For columns that were created using tabs, you can only select the text line by line.
For Windows: 
1. Click on "Start" in the menu bar at the top.
2. In the "Paragraph" area, click on the "Display all" button with the "¶" symbol. This makes all paragraph formatting in the document visible.
3. Now take a look at the columns in your document. There should be no arrow symbols "->" between the columns, as these arrows represent tabs.
4. Alternatively, you can also check whether you can select the texts column by column. For columns that were created using tabs, you can only select the text line by line.
To ensure that the space between the columns is large enough, you can adjust the column settings in Word. Here you can define the column spacing and ensure that it is large enough to separate the columns. To adjust the column settings in Word, proceed as follows:
1. Select the text you want to format in columns or position the cursor where you want to start the columns.
2. Click on the "Layout" tab in the menu bar at the top of the Word window.
3. Click on the "Columns" button, which is located in the "Page setup" group.
4. Select the desired number of columns and the width and spacing (min. 6 mm) between the columns.
5. Click on "OK" to apply the changes.
If you want to customise the column settings for the entire document, select the "Columns" option in the "Layout" menu under "Page setup". Enter the desired number of columns, the width and the spacing and click on "OK". The settings are now applied to the entire document.

[bookmark: _Toc159574772]3.9 Only content that is actually a list/enumeration is output as a list/enumeration. These are created with list or enumeration formats.
What is meant by this? 
List or enumeration formats in Word are special formatting options that can be used to create a list of items or points. There are two types of list formats in Word: unordered lists and ordered lists.
Unordered lists are lists in which the elements or items are marked with a symbol or a dot and the order plays a subordinate role. Ordered lists, on the other hand, are lists in which the elements or items are ordered numerically or alphabetically and the order is important.
In order to improve readability and comprehensibility, lists should be divided up sensibly. For example, advantages could be presented in one list and disadvantages in another. This structuring helps recipients to grasp and process the information more easily.
Overall, when using lists and enumerations, you should always ask yourself whether it is really necessary and sensible to use this formatting and whether it helps the recipient to understand the content.
Why is it important? 
The use of manually generated bullets can lead to the list not being recognised as a coherent list and therefore being inaccessible. If a list is not read out correctly by voice output and screen readers, recipients may have difficulty recognising the number of items in the list or may not understand it completely or in context. As a result, important information may not be correctly recognised. With the support of list and enumeration formats for lists, screen reader users can perceive them as a list and interpret them coherently. 
Structuring documents correctly is important for the General approval of the document. The use of lists or enumerations, if such a structure exists, facilitates navigation and improves the perception of the document. However, labelling text passages as lists or bulleted lists for visual distinction can lead to confusion and difficulties for screen reader and speech output users.
An example of a correct use of lists or enumerations would be a list of tasks that must be carried out in a specific order. An incorrect use of lists or enumerations, on the other hand, would be if a text passage is labelled as a list or enumeration for visual emphasis, although it is not a sequence or enumeration. 
How can I implement/check it?
To ensure that enumerations in Word are accessible to screen reader and speech output users, Word's integrated list function should be used. Lists can be formatted via the "Home" tab and the "Numbering" item. It is also important to ensure that the formatting of the list is consistent and that the elements of the list are organised logically. 
There are different procedures for checking list and enumeration formats on Mac and Windows operating systems: 
For Mac: 
1. Search the document for lists or enumerations that may already exist. These can be identified by numbering or bullet points.
2. Click on any list entry to ensure that you can edit the list.
3. Click on the "Start" tab at the top of the menu bar.
4. Look for the "Bullets" and "Numbering" buttons and click on them.
5. If one of the buttons has a dark background, this means that the list has already been created with the corresponding format.
6. Make sure that one of the two buttons is activated so that the accessibility criterion is met. If no option is activated, you can simply select the area in the document that you want to make into a list or enumeration.
7. Click on either the "Numbering" or "Bullets" button to format the list or enumeration.
8. Make sure that the order of the elements in the list is logical and easy to understand.
9. Check the list or enumeration to make sure it is complete and formatted correctly.
10. Repeat these steps for all other lists or enumerations in the document.
For Windows:
1. Search the document for areas that contain lists or enumerations. These can be identified by numbering or bullet points.
2. Select the area of a list or enumeration by selecting it with the mouse.
3. Click on the "Start" tab in the menu bar.
4. Check whether one of the "Numbering" or "Bullets" buttons is selected in the "Paragraph" area. If this is the case for one of the options, then the list or enumeration has been created with the correct format.
5. If none of the options are activated, select the area in the document from which you want to make a list or enumeration.
6. Then click on the "Numbering" or "Bullets" button to create the list or enumeration with the corresponding format.
To check the sensible use of lists, you can search for content in the document that is output as a list or enumeration. Check whether each of these areas actually represents a list or enumeration. Lists and bulleted lists should be used to present a group of similar or related items. If you think that the content is incorrectly displayed as a bulleted or numbered list, you can fix this by simply removing the bullets using the "Del" or "Backspace" key. Alternatively, it is also possible to click on the list function again.

[bookmark: _Toc159574773]3.10 Texts have a sufficient contrast ratio to the background of at least 4.5:1.
What is meant by this?
The contrast ratio in Word refers to the ratio between the brightness of the text and the background on which it is displayed. A high contrast ratio makes the text easier to read. A sufficient contrast ratio is achieved when the text colour stands out clearly from the background colour. The contrast ratio for normal texts is at least 4.5:1. Black text on a white background (or vice versa) represents the optimum contrast. If other colours are used, the contrast ratio must be checked.
Why is it important? 
A sufficient contrast ratio between text and background colour is of great importance, especially for recipients with impaired vision. If the contrast is not high enough, the text can be difficult or impossible to read, resulting in barriers to accessing information.
For example, recipients with colour blindness have difficulty distinguishing between certain colours. A sufficient contrast ratio helps to ensure that they can still read the text. If the contrast ratio between the text and the background is low, it can be more difficult to read the text, even if it is large. 
Sufficient contrast not only makes it easier for recipients with visual impairments to perceive content. Recipients who work in an environment with poor lighting conditions, have a printout in black and white or are watching a presentation via a projector also benefit from a high contrast ratio. Sufficient contrast ensures that the content is clearly recognisable, making it easier to absorb and process information.
How can I implement/check it?
If you find that your document does not match the default contrast ratio of black and white, you can either change the font colour or adjust the background colour to increase the contrast ratio in Word. Here is a simple guide on how to do this:
1. Select the text for which you want to increase the contrast.
2. Click on the "Font colour" button in the "Start" tab and select a colour with a higher contrast to the background colour.
3. Click on the "Background colour" button in the "Design" tab and select a colour with a lower contrast to the text.
4. Make sure that the contrast ratio between text and background is at least 4.5:1.
It is also important to note that Word contains some accessibility templates that have been specially developed for recipients with visual impairments. If you use one of these templates, the contrast ratio is automatically optimised.
To ensure that the contrast ratio between text and background is optimal, you can use online tools or downloadable programmes. These can automatically calculate the contrast ratio for you. 
If in doubt, it is advisable to opt for a dark text (preferably black) and a light background (white), as the contrast ratio of at least 4.5:1 is always given here. It is important to note that Word also performs an accessibility check to recognise if the contrast between text and background is too low when it is activated manually.

[bookmark: _Toc159574774]4. Link
[bookmark: _Toc159574775]4.1 URL does not appear as plain text in the body text. Instead, hyperlinks are inserted, clearly labelled and easy to understand.
What is meant by this? 
A URL (internet address or web address in everyday language) should not simply be copied into a continuous text. Instead, the URL should be integrated using a hyperlink. This should be named with a meaningful and understandable title.
Hyperlinks are clickable links within a document or to other documents, websites or files. A hyperlink can be created in Word in various ways, for example by adding a link to a specific section of the document, inserting a link to an email or linking a text or image to a web page. Hyperlinks are a useful feature in Word as they allow you to navigate quickly and easily between different sections of the document or between different documents and resources. 
It is also important that the corresponding links are not labelled "here" or "this link" or "more information". This designation says nothing about exactly what information is meant and where it can be accessed (see 4.2). 
Why is it important? 
Clear and precise naming of hyperlinks is very important to improve the approval of websites. If the URL is not replaced by a hyperlink, screen readers and speech output will lecture the complete URL (starting with "http"). It can therefore be very frustrating for screen reader users if the content of the link is not clear and the entire URL is read out instead. This can significantly impair the use of the document and approval of a website. 
How can I implement/check it?
To convert URLs into hyperlinks, there are different procedures for Mac and Windows operating systems: 
For Mac: 
1. Click on the link. 
2. Select the "Link" option in the context menu. A dialogue window opens.
3. Under "Text to be displayed" you can enter a clear and easily understandable name for the URL, e.g. consulate homepage.
4. Enter the link under "Address".
5. Click on "OK" to confirm the process.
For Windows: 
1. Select the entire URL and click on the "Paste" tab.
2. Select the "Link" button in the "Links" area.
3. A dialogue window opens. There you can enter a clear and easily understandable name for the URL under "Text to be displayed", e.g. "Homepage of the consulate".
4. Enter the link under "Address" and click on "OK" to save the process.
You can check it by clicking "CTRL" on the link and making sure that it leads to the intended destination.

4.2 If a link opens another programme (e.g. browser, email programme), this is indicated in the link text. Example: "Contact address (opens email programme)".
What is meant by this?
Hyperlinks can be created in Word that refer to different types of content, including programmes that are installed on the computer. If a hyperlink in Word refers to another programme, this programme is opened when the recipient clicks on the link.
It is important that the link text precisely describes the content of the link so that recipients know where they will be directed when they click on it. If the link refers to another programme, such as an email programme or a file, this should be made clear in the link text. 
Why is it important?
Specifying the format or programme in the link text can help recipients to better understand the content of the link and decide whether they want to click on it or not.  
It is particularly important for screen reader and speech output users to understand the content of the link and the associated context. By specifying the format or programme in the link text, screen reader users can better recognise that clicking on the link will lead to the opening of another programme and thus a new window, for example, and can adapt to this.
How can I implement/check it?
To ensure that the link text is unambiguous and clear, you should check it for comprehensibility. Is it immediately recognisable where the link leads and what action is being carried out? If not, you should adapt the link text to make it clearer.
You can also test if the link works as expected by clicking on it. If there are any problems, you should update or repair the link to make sure it works smoothly.
[bookmark: _Toc159574776]5. Heading
[bookmark: _Toc159574777]5.1 Headings are created using style sheets.
What is meant by this? 
When creating headings, style sheets should be used instead of manually emphasising them with bold print or underlining. This creates a clear structure in the document that enables screen readers and speech output devices, for example, to interpret the document better and reproduce the content correctly. 
Styles are predefined formatting that can be applied to text or paragraphs. These templates contain preset formatting properties. By using style sheets, headings can be easily and quickly formatted in a standardised way, which ensures a clear appearance of the document. In addition, the use of style sheets makes it easier to navigate through the document, as headings can be automatically listed in the table of contents.
Why is it important? 
If headings are formatted manually in Word, assistive programs such as screen readers or speech output cannot recognise them as such, which can affect the approval of the document for blind and visually impaired recipients. In addition, manual formatting can lead to inconsistency in the document, which interrupts the flow of reading and makes orientation within the document more difficult.
When creating documents, it is therefore important to ensure that headings are marked with style sheets to ensure uniform presentation and improved accessibility.
How can I implement/check it? 
To create headings with style sheets, you should proceed accordingly: 
1. Select the text that you want to format as a heading.
2. Go to the "Start" tab.
3. Search for the "Styles" section.
4. Select a suitable style, e.g. "Heading 1", "Heading 2", "Title", etc.
5. Click on the selected style sheet to format the text accordingly.
6. If none of the existing style sheets meet your requirements, you can create your own style sheet.
7. To do this, click on the down arrow next to "Styles" on your Windows computer and, if you are using a Mac, on the "New style" field under "Style area".
8. Select "New style sheet".
9. Enter a name for the new style and specify the desired formatting options.

There are different procedures for checking headings on Mac and Windows operating systems: 
For Mac:
1. Open the Word document you want to check.
2. Find the heading in the document that you want to check and click on it.
3. Click on the "Styles" area. In a new window, under "Current style", you can see which style has been selected for the heading as it is outlined in blue. The "Standard" style should not be selected for headings.
For Windows:
1. Open the document in which the heading to be checked is located.
2. Click on the heading that you want to check. This selects the text of the heading.
3. Go to the menu bar and click on the "Start" tab.
4. Click on the "Format templates" button or on the arrow pointing downwards.
5. A menu opens with various format templates, e.g. "Title", "Heading 1", "Heading 2" etc.
6. Check which style sheet was used for your heading. This is displayed by a grey frame around the text.
7. Make sure that a suitable style sheet is selected for your heading and that the default style sheet is not used.
8. If necessary, you can change the style sheet for the heading by clicking on another style sheet.
9. Then check whether the formatting of the heading meets your requirements.

[bookmark: _Toc159574778]5.2 The first heading has the style "Title" or "Heading 1".
What is meant by this?
The first heading in a Word document is usually the "title" of the document and should be formatted as such or as "Heading 1". This formatting signals the start of the document and is the highest hierarchical level that can be followed by further headings.
A style in Word is a predefined formatting that can be applied to text to change its appearance. When the "Title" or "Heading 1" style is applied to text, Word automatically changes the appearance of the text to identify it as a heading. As a rule, the text is printed larger and in bold to make it stand out from the rest of the text. This allows readers, screen readers and speech output devices to quickly identify and distinguish the headings and subheadings in the document. However, style sheets can also be customised.
Why is it important? 
If the first heading in a Word document is not formatted correctly, this can lead to various barriers, especially for recipients with impairments who rely on screen readers and speech output. Correct formatting with the "Title" or "Heading 1" style allows the screen reader to recognise where the document starts date and what the topic of the document is. This allows readers to decide whether the text is relevant to them or not.
How can I implement/check it?
1. Select the text that you want to use as the first heading in the document.
2. Select the "Start" tab or open the "Styles" menu to display the available styles.
3. Select the "Heading 1" style to ensure that the heading starts at the highest hierarchy level and is labelled correctly.
4. If the "Heading 1" style is not available or does not meet the requirements, you can create and customise a new style.
5. To do this, click on the arrow next to "Styles" and select "New style...".
6. Give the new style a meaningful name, such as "Title", and click "OK".
7. Select the new style sheet and adjust the settings according to your requirements, e.g. font, size and colour.
8. Use the new style to label the first heading in the document and ensure that it starts at the highest level of the hierarchy.
By following these steps, you ensure that the first heading in the document starts with level 1 and is labelled correctly. 
There are different procedures for checking the style sheet for headings on Mac and Windows operating systems: 
For Mac:
1. Search for the first heading, which should start with level 1.
2. Click with the mouse pointer on the text of the first heading to select it.
3. Click on the "Start" tab at the top of the menu bar.
4. Search for the "Styles" group and click on the "Styles section" button.
5. A menu with various styles will open, including "Title", "Heading 1", "Heading 2", etc.
6. Search for the "Heading 1" style and click on it to select it.
7. Under "Current style", check whether the correct style has been selected.
For Windows:
1. Click on the text of the first heading to select it.
2. Go to the "Start" tab in the menu bar.
3. Click on the "Styles" button, which is usually located in the "Formatting" group. Alternatively, you can also click on the arrow button pointing downwards to open the "Styles" menu.
4. A menu opens with possible format templates, e.g. "Title", "Heading 1", "Heading 2" etc.
5. Check which style was used for the first heading by looking at the grey frame around the text. The style should be either "Title" or "Heading 1".
6. If the correct style is not selected, click on the appropriate style to select it.

[bookmark: _Toc159574779]5.3 There are no headings below level 6.
What is meant by this?
Heading levels in Word refer to the hierarchy of headings in the document. Each heading has a level numbered from 1 to 9, with level 1 being the highest level and level 9 the lowest. The heading level determines the visual presentation and positioning of the heading in the document. A heading of level 1 is normally larger than a heading of level 2 and following. An example of a "Heading 6" in decimal format looks like this: 1.1.1.1.1.1.
Why is it important?
To ensure that the hierarchy of headings in a document is comprehensible, you should only use headings up to the sixth level, starting from the first level (heading 1) to the sixth level (heading 6). A missing or opaque hierarchy can impair the readability of the document and thus its accessibility. In addition, if a Word document is later saved as a PDF file, the headings beyond the sixth level may no longer be adopted. This means that important content and orientation is lost. Too many subheadings can also quickly lead to confusion and make it difficult to find your way around the document. 
How can I implement/check it?
The use of headings up to the sixth level can be implemented by only using the style sheets for headings up to the sixth level and ensuring that they are arranged in a clear hierarchy. The "Headings" function in Word can also be helpful here to check and adjust the hierarchy and the number of levels.
To avoid or check headings below the level, there are different procedures for the Mac and Windows operating systems: 
For Mac: 
1. Click on the "Start" tab at the top of the menu bar.
2. Click on the "Format templates" button.
3. A menu opens with possible format templates such as "Title", "Heading 1", "Heading 2" etc.
4. Under "Current style" you can see which style has been selected for the heading.
5. Make sure that the selected heading level is not higher than "Heading 6".
6. Alternatively, you can also open the navigation area and view the levels of the headings there.
7. To do this, click on "View" in the menu bar at the top.
8. Then activate the "Navigation area" option.
9. Click on the "Document structure" button in the navigation area.
10. There you will see the levels of the headings and can also check them.
For Windows:
1. Click on the "Start" tab in the menu bar.
2. Click on the "Format templates" button or on the arrow button pointing downwards.
3. A menu opens with possible format templates such as "Title", "Heading 1", "Heading 2" etc.
4. See which style sheet was used for your heading. This is marked by a grey frame.
5. Make sure that the style "Heading 7" or higher is not selected for any heading. 
Alternatively, you can also open the navigation pane and view the levels of the headings there. To do this, click on "View" in the menu bar at the top and then activate the "Navigation pane" option.

[bookmark: _Toc159574780]5.4 If there are subheadings, there is every level without skipping a level.
What is meant by this?
A clear and stringent hierarchy of headings in a document is important to ensure a logical and structured presentation of the content. If subheadings are used, all levels of the hierarchy should be considered in order to avoid a gap in the structure. A main heading, such as the title, should therefore be followed by a level 1 subheading, then a level 2 subheading and so on. This ensures that readers understand the relationship between the different sections of the document, making it easier to navigate through the document.
Subheadings are headings that are placed below a higher level of headings within a document. They serve to further subdivide and structure the content. For example, a main heading could be "Accessibility", under which there are then subheadings such as "Importance" and "Benefits".
Why is this important? 
To ensure that the document is accessible for all recipients, there should be clear and consistent subheadings at each level. This is particularly important for recipients who have the document lectured to them and rely on the headings to help them navigate.
A correct hierarchical structure ensures that users of screen readers and speech output devices can find the content quickly and easily by jumping from heading to heading. However, if the hierarchical structure is not correct, it can be difficult to recognise the connection between the headings and the corresponding text sections and to understand the content of the document. 
How can I implement/check it?
To ensure that subheadings in a document take into account each level of the hierarchy, clear and consistent formatting guidelines should be defined. Word offers various formatting functions to create headings and subheadings of different levels (see 5.1). 
There are different procedures for checking the level of sub-headings on Mac and Windows operating systems: 
For Mac:
1. Click on the first heading in the document.
2. Go to the menu bar and click on the "Start" tab.
3. Click on the "Format templates area" button or on the arrow button pointing downwards.
4. A menu with possible format templates such as "Heading 1", "Heading 2" etc. opens.
5. Under "Current style" you can see which style has been selected for the selected heading.
6. Check whether the first heading has the "Heading 1" style. If the first heading has a subheading, this should have the style "Heading 2" and so on.
7. Repeat these steps for all other headings and subheadings in your document to ensure that they all have the correct styles.
For Windows:
1. Click on the "View" tab in the menu bar.
2. Activate the "Navigation area" option in the "Display" area.
3. All headings in the document that were created with a corresponding style sheet are displayed in the navigation area.
4. Click on the first heading in the navigation area.
5. The document now scrolls to the corresponding heading in the main text.
6. Click on the "Start" tab in the menu bar.
7. Click on the "Styles" button in the "Styles" area.
8. Check whether the first heading in the document is formatted with the "Heading 1" style.
9. Select the next subordinate heading in the navigation area, if available.
10. Check whether it is formatted with the "Heading 2" style.
11. Repeat the process for all other sub-headings.
12. If a style level has been skipped, this must be adjusted for the corresponding heading and all other subheadings.

[bookmark: _Toc159574781]5.5 The heading is labelled exclusively with Arabic numerals ("1"), not with Roman numerals ("I"). 
What is meant by this?
In a list or in headings, only Arabic numerals (e.g. 1, 2, 3) should be used for numbering and not Roman numerals (e.g. I, II, III).
Arabic numerals are the most common way of writing numbers today. Roman numerals, on the other hand, are a way of writing numbers that uses letters of the Latin alphabet to represent numbers.
Why is it important?
The use of Arabic numerals represents the international standard for the representation of numbers and is used for the communication and exchange of information in different countries and languages. The use of Roman numerals in headings can pose a challenge for some recipients and lead to comprehension difficulties. This represents a linguistic barrier. Screen readers and voice outputs also have problems with the correct pronunciation of Roman numerals, as these can represent both letters and numbers. For example, the screen reader may read out "V" (for 5) as the letter "V" instead of the number "5", which can lead to confusion or misunderstandings. This can be particularly problematic with more complex documents where clear and accurate numbering is important to understand the content.
How can I implement/check it?
To ensure that only Arabic numerals are used for numbering in lists or headings, you should check the numbering settings for the respective headings and lists in Microsoft Word and switch to the use of Arabic numerals if necessary. You can do this in Word under the "Start" tab and then "Numbering".
To check the designation of the headings, there are different procedures for the Mac and Windows operating systems: 
For Mac:
1. Check the formatting of the headings in the document. If Roman numerals have been used, you should convert them to Arabic numerals.
2. Right-click on the Roman numeral you want to change.
3. Select the "Numbering and bullets" option in the context menu.
4. A dialogue window opens. Click on the "Outline" tab.
5. Select a suitable heading structure. This can be "Heading 1", "Heading 2" etc., for example.
6. If you want to change the number format template, click on the "Customise" button. You can change the appearance of the numbers here, for example.
7. Confirm the changes by clicking on "OK".
For Windows:
1. Look at the headings in the document to check whether they are numbered with Roman numerals.
2. If so, select the heading whose numbering you want to change.
3. Click on the "Numbering" button in the "Paragraph" area on the "Start" tab.
4. Select an option with Arabic numerals from the "Numbering library".
5. If no suitable option is available, click on "Define numbering format" and select the "Arabic" option under the "Numbers" tab.
6. Confirm your selection with "OK".
7. Repeat these steps for all headings that use Roman numerals.
8. Save the document.
Please note that depending on how the Roman numerals were used in the document, the conversion to Arabic numerals may lead to unexpected results. It is therefore advisable to check the document carefully after conversion to ensure that the numbering is correct.

[bookmark: _Toc159574782]5.6 Headings, figure and table captions appear only once, are meaningful and easy to understand. 
What is meant by this? 
Headings, figure and table captions should only appear once in a document in order to improve the readability and clarity of the document. In addition, it is important that headings, figure and table captions are meaningful so that they quickly and effectively help readers to understand the content of the relevant sections or elements. Figure and table captions should also contain all the necessary information to help readers understand the data or information presented and, if necessary, refer back to the sources used. 
Why is it important? 
A clear structure is crucial for quickly grasping and understanding content. Headings and labelling play an important role here, as they help to structure the content of the document and quickly identify key sections and elements. This is particularly important for recipients with visual impairments, learning disabilities or reading difficulties, as clear structuring facilitates approval of texts. A precise and meaningful heading, for example, enables readers to quickly scan the text and decide whether or not they want to continue reading. Figure and table labelling should also be precise and meaningful in order to enable easy comprehension and clear classification. Clear and precise labelling of figures and tables can also help to avoid misunderstandings and confusion, especially if several figures or tables appear in the same document. 
How can I implement/check it? 
When selecting headings, figure and table captions, you should follow a few principles to ensure that they are appropriate to the content and easy to understand:
1. Describe the content precisely: The heading or caption should be short and concise and describe the content of the document or figure/table.
2. Use clear and simple language: Avoid technical jargon and instead use language that is easy for the target group to understand.
3. Use keywords: Use relevant keywords that give the reader an idea of what to expect in the document or figure/table.
4. Use formatting: Use a larger font size or bold type to emphasise the heading or caption and make it easier to read.
5. Check accuracy: Make sure that the information in the heading or labelling is correct and does not lead to misunderstandings.
6. Avoid repeated labelling: Avoid repeating captions or headings in the document to avoid confusion.
7. Consider the target group: Make sure that the headline or labelling is tailored to the needs and knowledge of the target group.
8. Use the correct spellings and symbols: Use correct spelling and grammar, and use symbols and abbreviations that are understood by the target audience.
By following these principles, you can create headings, figure and table captions that are appropriate to the content and easy to understand.
The targeted placement of an image or table caption makes it possible to position it exactly where you want it and thus create a clear link between the caption and the associated element. As a rule, this function can be selected by simply right-clicking on the element, which makes it easier to place the label in the desired position and ensure that it does not appear isolated. 
You can also check whether headings, figure and table captions only occur once in the document by searching the document specifically. The procedure differs depending on the operating system: 
For Mac:
1. Use the search function by pressing CMD+F.
2. Enter the heading or caption to be checked in the search field and press the ENTER key.
3. Check all occurrences of the heading or labelling in the document to ensure that they are only used once.
4. Check the language of the headings and labelling for comprehensibility for the target group.
5. Avoid jargon or technical terms that may not be understandable for the target group.
6. Revise the headings and labelling, if necessary, to make them clearer and more concise.
For Windows:
1. Open the navigation pane in Word by pressing CTRL+F.
2. Enter the heading or labelling to be checked in the search field.
3. Only one entry should be displayed under the "Results" tab. If there are several entries, this means that the phrase entered occurs in several places in the document.
4. Click through the entries and see if there are any duplicate headings or labelling. Also check whether these phrases only appear in continuous text.
5. Check that the headings and labelling are written in clear and concise language. Avoid jargon or technical terms that may not be understandable for the target group.

[bookmark: _Toc159574783]6. Graphic
[bookmark: _Toc159574784]6.1 Inserted graphics and text fields are anchored in the appropriate place.
What is meant by this?
Anchoring in Word means that graphics and text fields are placed in a fixed position in the document. This means that they remain in the intended position and do not move, even if changes are made to the text flow or additional content is inserted. 
In Microsoft Word, "inset text boxes" are a type of element that can be inserted into a document to organise and highlight text and other elements. A text box is a limited area in the document into which text or other content, such as images or tables, can be inserted. 
Why is it important? 
Correct anchoring of text fields and graphics in the Word document is important to ensure consistent and accessible readability of the document. If elements are not anchored in the right place, this can lead to distortions or ambiguities in the perception of the document when using screen readers and speech output. 
For example, a non-anchored image and its alternative text can be read aloud by screen readers in the wrong place, leaving text and image relationships unclear. To avoid this, all text fields and graphics in the document must be anchored correctly.
How can I implement/check it? 
There are different procedures for anchoring text fields and graphics on Mac and Windows operating systems: 
For Mac:
1. Right-click on the text field or graphic that you want to anchor or alternatively click on the "Menu" tab and then on the "Layout" item and the "Position" sub-item. 
2. Select the "Size and position..." option in the context menu.
3. Then select "Anchor" under "Position".
4. Select the "Fixed position on the page" option under "Options".
5. If the option is greyed out, you must first select a suitable text wrap, such as "Rectangle", "Outline" or "Top and bottom".
6. Click on "OK" to save the changes.
For Windows:
1. Click on the text field or the graphic that you want to anchor.
2. Click on the "Format" tab at the top of the menu bar.
3. In the "Arrange" area, you will find the "Text wrap" button. Click on it.
4. If the "Fix position on page" field is greyed out or does not have a tick, this means that the text field or graphic has not yet been anchored.
5. Click on the "Position" button and select one of the "With text wrap" options.
To ensure that text fields and graphics are correctly anchored, you can switch to "Draft view" mode in Word and check whether the position of the elements changes when the text flow changes or when additional content is inserted in the document. 

[bookmark: _Toc159574785]6.2 Graphics contain a short, concise alternative text. Graphics with no substantive meaning are marked as decorative.
What is meant by this? 
To improve the approval of a Word document, all images and graphics contained in it should be provided with alternative texts that describe what can be seen in the image. An alternative text is a short and concise description of the content of the graphic that is read by screen readers and speech output devices to understand the content.
In the case of purely decorative images with no relevance to the content, the image should be labelled accordingly. In Word, a graphic or image can be marked as "decorative" to indicate that it does not contain any content relevant to the document and can therefore be skipped by screen readers. 
Why is it important? 
A suitable alternative text for an image is important as it enables all recipients to understand the content of an image. If an image has no alternative text or the alternative text is insufficient, the image becomes invisible to screen reader and speech output users. This means that these recipients miss out on important information that could be contained in the image. 
An appropriate alternative text describes the image briefly and concisely and conveys how an image relates to the content of the document, for example. If the image contains important information that is not or cannot be presented differently in the text, it is important to include this information in the alternative text so that it can be recognised by screen readers and speech output. A detailed description of the image is not usually necessary for an alternative text. If an image contains a lot of important information, this should be included in the text itself or a detailed text alternative (4.3) should be provided. As a general rule, an alternative text should contain a maximum of 120 characters.
An example of a suitable alternative text for an image in Word would be: "A group photo of employees who took part in a company outing and are standing together in front of a mountain panorama." This alternative text tells users of a screen reader what can be seen in the image. 
How can I implement/check it?
To add an alternative text for an image in Word, left-click on the image and select "Alternative text" from the "Image format" menu. Then enter a precise description of the content of the image in the text field. If the image is only decorative, mark it as such and leave the alternative text field empty. To mark an image as decorative, proceed as follows:
1. Select the image you want to mark as decorative.
2. Right-click on the image and select "Format Image" from the drop-down menu if you have a Windows computer. Alternatively, if you have a Mac, you can select "Display Alt Text" and a window/menu will open on the right-hand side
3. Select the "Alt text" item in the "Image format" tab.
4. In the Alt Text dialogue box on a Windows computer, select the "This image is decorative" checkbox, while on a Mac you can select the "Mark as decorative" option below the text field. 
5. Click on "OK" to save the changes.
Word offers an integrated function that allows you to check whether an alternative text exists for a picture or not. You can also check for redundant alternative texts by reading the text around the image and ensuring that it does not match the alternative text.
To use the integrated function in Word that allows you to check whether an alternative text exists for an image, proceed as follows:
1. Select the image for which you want to check the alternative text.
2. Right-click on the image and select "Format Image" from the drop-down menu. With a Mac, you can alternatively select "Display Alt Text" and a window/menu will open on the right-hand side
3. Select the "Alt text" item in the "Image format" tab.
4. Check whether the text field for the alternative text is filled in. If so, the image contains an alternative text. If not, the alternative text is missing and should be added.
Word automatically generates its own ALT texts on request, but in many cases these do not fit and should therefore be checked and adapted if necessary.
[bookmark: _Toc159574786]6.3 Complex images (e.g. comics, SmartArts, diagrams) have a detailed descriptive text alternative. 
What is meant by this? 
A detailed descriptive text alternative for an image contains a detailed description of the image content and its significance for the document. In contrast to an alternative text, which only contains a brief summary of the image content, a full descriptive text alternative should convey all the important details of the image that are necessary for the image to be understood. A full descriptive text alternative should use clear and concise language and include all the important information of the image, including colours, shapes, text, staff, people, places and actions depicted in the image. However, the text should not be redundant or superfluous and should be limited to the relevant information contained in the image.  
If a text alternative is required for a visual representation, this should be provided either in the same document or in a separate document. The text alternative should be included in the same document as the image and located close to the image. This makes it easier for recipients who need a description of the image to find the text alternative. If the text alternative is provided in a separate document, a link to the text alternative should be included in the document and made accessible. 
Why is it important?
The use of fully descriptive text alternatives is an important aspect of digital content accessibility as they ensure that visually impaired users can understand the content of complex images and diagrams. A detailed descriptive text alternative can be particularly important if the image contains important information that cannot be presented in any other way in the text of the document. As complex images are usually difficult to describe, it is particularly important that they are accompanied by a precise and detailed text alternative so that everyone can understand the content of the image.
An example of a detailed descriptive text alternative for a complex picture could look like this: "The picture shows a group of people sitting at a round table and discussing. In the centre of the table is a cake with "Happy Birthday" written on it. The staff, people are walking around the table, smiling and raising their glasses to toast the birthday. The room is decorated with balloons and garlands and you can see a band playing music in the background." The more important the details are for understanding the content, the more detailed they need to be described.
How can I implement/check it? 
A descriptive text alternative should contain a precise and accurate description of the visual element (e.g. image, diagram, graphic) and convey its importance to the content of the document. Here are some steps that can help you create a good descriptive text alternative:
1. Identify the visual element: Think about which visual element is to be described and what information it contains.
2. Describe the visual element: Describe the visual element in as much detail as possible to ensure a clear picture of what is shown in the image or diagram.
3. Consider the context: Consider how the visual element fits into the context of the document and what information it conveys. Make sure that the text alternative helps the reader to understand the meaning of the visual element in the context of the document.
4. Use clear language: Use clear, simple language and avoid technical terms or abbreviations that may be difficult to understand.
5. Avoid redundancy: Avoid repeating information that already exists in the text of the document.
There are a few steps you can take to check your text alternatives:
1. Check whether the text alternative contains all the important information of the visual element.
2. Make sure that the text alternative is understandable and easy to read.
3. Check whether the text alternative makes sense in the context of the document and has a clear connection to the text or other visual elements.
4. Ask someone who does not know the information in the visual element to read the text alternative and check that they can understand the meaning and purpose of the visual element.
5. Check that the text alternative is not redundant, i.e. that it does not repeat any information already in the text.

[bookmark: _Toc159574787]6.4 No images or WordArt are used to display text ("font graphics"). Exception: Essential font graphics have a meaningful alternative text. Redundant font graphics are labelled as decorative (see 6.2).
What is meant by this? 
It is recommended not to display text using font graphics. Instead, the text should be typed and formatted as actual text. If font graphics are still used, it is necessary to provide an alternative text that describes the content of the graphic. If the font graphics are redundant and contain the same text as the surrounding text, they should be labelled as decorative.
Type graphics are graphics that consist entirely of text characters and symbols and do not contain images, photos or other visual elements. Font graphics are often used for the design of logos, posters, banners and other marketing materials. WordArt is a font graphic that allows users to design text in different styles and shapes. 
Why is it important?
The use of font graphics can lead to limitations in the accessibility of digital content, as they cannot be recognised by screen readers or voice output for recipients with visual impairments. If the text is entered and formatted as real text, it can be read more easily by assistive devices. However, if written graphics are used, it is important to provide alternative text to ensure that the content of the graphic can be understood by all recipients.
How can I implement/check it? 
To avoid font graphics in Word, you should enter and format the text as real text instead of inserting it as an image or WordArt. If you do use font graphics, you can enter an alternative text by right-clicking on the graphic and selecting "Alternative text". Enter a description of the text in the graphic in the "Description" field.
If the font graphics are redundant, you can mark them as decorative by right-clicking on the graphic and selecting "Mark as decorative".

[bookmark: _Toc159574788]6.5 Graphic information-bearing elements (e.g. lines, neighbouring areas) have a minimum contrast of 3:1 to the background.
What is meant by this?
Graphic information-bearing elements are visual elements that convey information in a document. These include, for example, lines, neighbouring areas and other graphic "aids". If these are used in Word, they must have a minimum contrast of 3:1 to the background of the document. The minimum contrast refers to the ratio or difference in brightness or colour depth between the two colours in graphic elements and the background.  
Why is it important? 
For recipients with visual impairments, sufficient contrast between graphic elements and the background can be crucial for recognising them. Insufficient contrast makes it difficult to recognise and can lead to misinterpretation. It is therefore important that graphic elements such as images or buttons have a sufficient minimum contrast.
Sufficient contrast not only makes it easier for recipients with visual impairments to perceive content. Recipients who work in an environment with poor lighting conditions, have a printout in black and white or are watching a presentation via a projector also benefit from a high contrast ratio. Sufficient contrast ensures that the content is clearly recognisable, making it easier to absorb and process information.
How can I implement/check it?
There are various options in Word for implementing a minimum contrast of 3:1:
1. Use high-contrast colours: Select colours that have a high contrast to each other, e.g. black on white or yellow on black.
2. Use the integrated colour schemes: Word offers a variety of built-in colour schemes specifically designed for good readability and contrast. You can find these options by navigating to the menu item "Design" and selecting the sub-item "Colours".
3. Check the contrast with an online tool: There are various online tools that can calculate the contrast between two colours and display whether the minimum contrast of 3:1 is achieved. You can use these tools to ensure that the contrast of your colour combinations is sufficient.
However, it is important to note that the minimum contrast of 3:1 is only the absolute minimum value and it is advisable to use a higher contrast, especially if the document is intended for recipients with visual impairments or reading difficulties.
To ensure that the contrast ratio between graphic information-bearing elements and the background is optimal, you can use free online tools or downloadable programmes. 

[bookmark: _Toc159574789]6.6 No animated graphics (GIFs) are used.
What is meant by this?
Animated graphics in the form of GIF files should not be used in a document. Animated graphics or GIFs (Graphics Interchange Format) are file formats for graphics that can play a sequence of images in a loop to create a short animation. The looping function means that GIFs are played over and over again until the viewer closes them or scrolls further. Still images can also be converted to GIF format, but this significantly reduces the quality. 
Why is it important?
The use of animated graphics should not be used in the design of accessible digital content. It is important to note that animated GIFs generally do not offer the option of pausing or stopping the animation, which makes it difficult for recipients with concentration difficulties, for example, to grasp the content of the document. Fast movements or flickering effects can also trigger seizures in some recipients with photosensitivity.
How can I implement/check it?
You can switch to static graphics or images to convey information instead of using animated GIFs. Depending on the operating system, the check for GIFs is carried out in two different ways: 
For Mac:
1. Check whether there are animated graphics in the document.
2. If so, consider whether these graphics add value to the content of the document.
3. If the animated graphics have no added value, remove them from the document.
4. If you want to keep the graphic, switch off the animation.
5. Right-click on the animated graphic.
6. Select the "Cut" option.
7. Now click on "Start" in the menu bar at the top.
8. Click on the arrow symbol next to the "Insert" button.
9. Select the "Insert as image" option.
10. The image should no longer be animated.
For Windows:
1. Look at all the graphics in the document and pay particular attention to those that move.
2. Check whether the moving graphics add value to the content of the document. If not, you should remove them.
3. If you want to keep the graphic still, click on it with the right mouse button.
4. Select the "Cut" option from the context menu.
5. Right-click again at the point where you want to insert the graphic again.
6. Select the "Insert" option and then "Graphic" from the menu.
7. The image should now be inserted as a static graphic without movement.

[bookmark: _Toc159574790]7. Table
[bookmark: _Toc159574791]7.1 Tables are created via "Insert table". 
What is meant by this? 
To create a table in Word, the "Insert table" function must be used instead of using tabs. If you select this function, you can specify the desired number of columns and rows for the table. An empty table is then inserted into the document, which can be filled with content or supplemented with additional columns and rows. 
Why is it important? 
Careful creation of tables is particularly important to ensure that the content of a document is accessible and can be perceived by all readers. In particular, users of screen readers and speech output devices who rely on the acoustic output of texts need clear structures in tables in order to make sense of the content.
If a table is not inserted or structured correctly, this can lead to various problems. For example, the screen reader may not be able to display the content in the correct order or in full. It can also happen that cells that belong together in terms of content are not recognised as a unit, which can lead to confusion or errors in interpretation.
How can I implement/check it?
In Microsoft Word, you can insert a table by going to the "Insert" tab and selecting the "Table" option. You can then specify the number of columns and rows and fill the table with content. 
To check whether a table has been inserted correctly, proceed as follows: 
1. Right-click on the top left or bottom right corner of the table.
2. If the table was created using the "Insert table" function, you should be offered various options for editing the table, e.g. "Delete table", "Table properties", etc.
3. If you do not see these options, you should recreate the table using the "Insert table" function. You can find this function at the top of the menu bar under "Insert" in the "Table" area.
4. Click on "Insert table" and select the desired number of columns and rows.

[bookmark: _Toc159574792]7.2 All column headings (first line) are marked as "Header", all line headings (if available) as "First column". The first line with the column headings is repeated as the "Header" on each page.
What is meant by this? 
A clear structure in tables is achieved using column and row headings. The header displays how the content is organised in the columns, while the "First column" sorts the content within the rows. To ensure that a table can be read out correctly by a screen reader or voice output, the column and row headings should be marked as "Header row" and "First column" respectively.
The "header row" of a table in Word is the top row of the table, which normally contains the column headings. The header row is used to identify and organise the content and structure of the table. It should be displayed on each new page of multi-page tables.
If all column headings are marked as "Header", they help to present the contents of the table clearly and comprehensibly. The same applies to row headings that are marked as "First column". These markings make it possible to perceive the table content correctly and clearly.


Why is it important? 
Incorrect formatting of tables can result in the content and structure of the table being unclear or incomprehensible to screen reader users. For example, if column or row headings are not marked as "Header" or "First column", the screen reader cannot interpret the structure of the table correctly and cannot understand the order within the table. As a result, important information may be lost or misunderstood.
If the header of a table is not repeated on every page, this can lead to confusion and misinterpretation of the content.
For complex tables in particular, it can be helpful to repeat the column labels on each page. This repetition provides recipients with better orientation and makes it easier to correctly allocate the contents of the table. Screen reader users also benefit from the repetition of the header, as this is also read out at the top of each page. This means they do not have to constantly remember the column headings or keep returning to the beginning of the table to keep their bearings.
How can I implement/check it?
In Microsoft Word, the first row of a table is automatically marked as a "header row". The "Header" box in the "Table design" tab is ticked. The first column can be marked as the "First column" by going to the "Table design" tab and selecting the corresponding options. You only need to mark the first column as such if there is a heading or order for the row. 
To check a table for this, proceed as follows: 
1. Click in the first cell of the table.
2. Go to the table design in the menu bar.
3. Look for the checkboxes for "Header" and "First column" on the left-hand side of the menu and check whether they are activated. 
To mark the header row of a table as such and make it visible on every page, proceed as follows: 
1. Select the first line and then go to "Table design" or right-click "Table properties". 
2. There, tick the option "Repeat the same header row on every page". This also allows you to check whether there is a header row on every page of the table.  

[bookmark: _Toc159574793]7.3 Page breaks in table rows are disabled for tables that extend over more than one page.
What is meant by this? 
Page breaks in table rows occur when a table row does not fit on one page and parts of the text are moved to the next page. To ensure the readability and comprehensibility of a multi-page table, page breaks in table rows should be avoided. In concrete terms, this means that automatic page breaks within table rows are prevented. Instead, longer text within a row is not split and is displayed on one page to ensure better readability and comprehensibility of the entire table.
Why is it important? 
If page breaks in table rows are not prevented, various problems can occur. For example, cells or columns may be displayed on different pages and the relationships between them may be lost. The contents of table cells can also shift if rows are moved to another page, making the table as a whole difficult to read. A clear and well-structured table is therefore essential for the accessibility of documents. In particular, recipients who use speech output or a screen reader can quickly lose their bearings if table rows are split over two pages, as screen readers interrupt the reading flow to announce the new page and read out further information at the top of the page. 
By suppressing page breaks in table rows, the clarity and structure of the table is improved. Information in the table cells remains uninterrupted and the connection between the individual data is maintained. 
How can I implement/check it? 
Depending on the operating system, implementation is carried out in two different ways: 
For Mac: 
1. Go to the table with the mouse and click with the right mouse button on the top left or bottom right corner of the table. A context menu opens.
2. Select the "Table properties" option from the context menu.
3. In the window that opens, select the "Line" area.
4. Make sure that the "Allow page break in line" option is not activated. If this option is activated, deactivate it by removing the tick in the corresponding box.
For Windows:
1. Go to the table with the mouse and click with the right mouse button on the top left or bottom right corner of the table. A context menu is displayed.
2. Select the "Table properties" option in the context menu.
3. In the "Table properties" window, select the "Row" area.
4. Make sure that the "Allow line breaks on pages" option is not activated. If the box next to it is ticked, click on it to deactivate it.
5. Click on "OK" to save the changes.
Deactivating the "Allow row changes on pages" option ensures that table rows are not split across two pages and that the table as a whole remains easier to read and understand.
To check whether page breaks in table rows are prevented in a table, you can go through the table and check whether all table rows are displayed completely on one page. If the content in a row is too large, it is advisable to either shorten it, split it up or consider alternative display options.

[bookmark: _Toc159574794]7.4 Cells are not connected to each other.
What is meant by this? 
Each row should have the same number of columns to ensure that the content can be assigned to the correct column heading. If the cells in a table are linked together, this can lead to confusion and ambiguity, as readers cannot be sure which column heading the content must be assigned to.
Why is it important? 
If table cells are merged, this can lead to problems as the information can no longer be assigned to the corresponding column headings. This can lead to the information being interpreted incorrectly or incompletely, which can lead to errors or misunderstandings. This can happen in particular when the table is viewed enlarged. Users of screen readers and speech output devices also face challenges in correctly assigning and interpreting the cells when they are connected. To avoid such problems, tables should be formatted in such a way that each cell can be assigned to a specific column and the information is easy to interpret. 
How can I implement/check it?
To ensure that the cells in a table are not connected to each other, table cells should not be merged. If it is necessary to place additional information in a cell, new rows or columns can be added for this purpose. However, it is important to ensure that each row has the same number of columns so that the content can be assigned to the correct column headings. If too much information is placed in a table, either the table should be split into several tables or an alternative display format should be selected.
You can check whether the cells in a table are connected to each other by checking the table for cell overlaps. In Microsoft Word, you can check the table structure and detect cell overlaps by manually inspecting the table visually or by using accessibility checking tools such as screen readers.

[bookmark: _Toc159574795]7.5 Complex tables are divided into several simple tables.
What is meant by this? 
Complex tables are tables that contain a larger number of columns and rows and may represent multiple levels of data and information. They can be used, for example, in scientific reports, financial reports or in data analysis. Complex tables often contain different types of data, including numerical, textual and graphical data.
Why is it important? 
A clear breakdown of tables is essential to ensure that they are accessible to all. This is particularly important for visually impaired recipients who hear the document read aloud.
By splitting complex tables into simpler tables with clear headings and structures, the readability and comprehensibility of the document can be improved. Recipients with other impairments such as concentration problems or learning difficulties also benefit from this structure. 
An example of this could be a financial report table that shows various key financial figures such as turnover, profit and loss. If this table is very extensive and contains a lot of complex information, it can be difficult to interpret for some recipients. By splitting it into several tables, for example a table for turnover, a table for profit and a table for loss, the information can be presented in a clearer and more understandable way.
How can I implement/check it?
Splitting a complex table into several simple tables in Word is relatively simple and can be done in the following steps: 
1. Select the cells that you want to split into a separate table.
2. Click on the "Layout" tab in the Word menu bar.
3. Click on the "Share" button in the "Merge" group.
4. Select the "Split table" option from the drop-down menu.
5. Enter the number of columns or rows into which you want to divide the table.
6. Click on the "OK" button.
7. Repeat steps 1 to 6 until you have split all cells into separate tables.
8. Check the formatting and alignment of the tables and adjust them if necessary.
To check your document for complex tables, take a look at the tables in the document. Are there any tables that you think are complex? Think about how you can divide the information into several, simple tables. 
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